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Summary 

Confocal laser scanning microscopy is an excellent tool for non-destructive imaging of 

arthropods and can provide detailed information on morphology including fine surface detail. 

A methodology is presented here for the visualisation by confocal microscopy of arthropods, 

using brachyuran crab zoeal stages as examples and post-processing techniques derived from 

micro-CT protocols to improve the final images. This protocol is divided into description of 

the pre-processing steps (cleaning, staining, digesting and mounting), confocal laser scanning 

microscopy and data visualisation using open-source, freeware programmes ImageJ and 

Drishti. The advantages of using ImageJ to standardise stack data and Drishti for surface 

rendering are discussed. The methodology has been comprehensively tested using data 

acquired from all four brands of confocal microscope (Leica, Nikon, Olympus and Zeiss).  

 

Introduction 

Confocal laser scanning microscopy (CLSM) offers an excellent option for non-destructive 

imaging of brachyuran crab larvae and other macro-invertebrates (Butler et al., 2010). The 

images obtained are comparable in quality to scanning electron microscopy (SEM) at the same 

magnifications and the technique offers a 3D data set. In addition, the sample preparation 

routine for CLSM is simpler than that for SEM. Applying SEM protocols to individual larval 

appendages (which may be only a few hundred microns in length and tens of microns in 

diameter) can be difficult (Wolf, 2010) and often results in them being damaged (Michels, 

2007) or even lost during the preparation steps due to the fact that they are so small. Finding a 

suitable SEM dehydration protocol which does not result in distortion of the cuticle, 

particularly in larval specimens, has proven to be extremely challenging (Wolf, 2010), whereas 

samples are examined in a hydrated state for CLSM. This allows the appendages to be 

manipulated within the mounting medium to offer views of the specimen from multiple angles 
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which can be problematical to achieve using SEM since some viewpoints may be inaccessible 

due to the way that the specimen is mounted and the tilt limitations in the SEM (e.g. Fig. 1a). 

Since CLSM is an optical technique, the transparency of the sample allows the origins of 

spines/setae and internal anatomy (musculature, digestive or nervous system) to be 

viewed/recorded and specimens held in historical slide collections to be examined/compared 

with recently collected material. CLSM illustrations can include much finer details than the 

traditional line drawings (e.g. Fig. 1b, c) for morphological descriptions, which are incredibly 

time consuming (Coleman, 2006) and figuring dense concentrations of setae can be 

challenging. Furthermore, CSLM samples can be recovered after imaging and used for DNA 

extractions. 

Previous studies have described a number of different techniques for applying CLSM 

to macro-invertebrates including the use of a variety of stains, mounting media, and cleaning 

protocols (Table 1). However, one issue with CLSM visualisation is that the software is 

optimized for generating images of transparent, fluorescent volumes rather than for rendering 

and lighting surfaces. Commercial software capable of producing this type of visualisation 

tends to be expensive. Workflows can be developed to allow the use of the open-source 

freeware programme “Drishti” (http://sf.anu.edu.au/Vizlab/drishti/; Limaye, 2012) to visualise 

CLSM data (e.g. Fig. 1d).  

The purpose of this study is to demonstrate a workflow for the 3D imaging of 

arthropods using CLSM and visualisation using a combination of ImageJ and Drishti to process 

the resulting data. The first stage of the workflow, as detailed in the pre-processing section of 

this paper, is the application of improved cleaning, staining, digestion and mounting protocols 

to the specimen prior to scanning. The second stage is scanning of the specimens using a Nikon 

A1-Si confocal microscope. The third stage is a specific method for processing the resulting 

image stacks using the open source software programmes ImageJ and finally apply Drishti for 

http://sf.anu.edu.au/Vizlab/drishti/
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3D visualisation. The data presented here was obtained using a Nikon CLSM, however, the 

third stage of the workflow was also tested using comparable datasets obtained using confocal 

microscopes from Leica, Olympus and Zeiss. A common workflow for preparing data from 

different brands of confocal microscope for 3D visualisation has been created using ImageJ 

(http://imagej.nih.gov/ij/; Schneider et al., 2012) and the results were found to be consistent 

across all instruments tested. This method is detailed in the post-processing (3D modelling) 

section of this paper. 

 

Materials and Methods 

Source of larvae 

Eriocheir sinensis H. Milne Edwards, 1853; ovigerous female; Tilbury, River Thames, 

England; collected by Roni Robbins, 16 March 1999; hatched 14−16 April 1999; Natural 

History Museum, London (NHM) registration number 2002.791.  

Sesarma curacaoense De Man, 1892; ovigerous female; coastal mangrove swamp near 

Mangrove Point, Trelawny, northern Jamaica; collected March 1993 (see Anger et al., 1995).  

Armases miersii (Rathbun, 1897); ovigerous female; Devil’s Cook Room, Trelawny, Jamaica; 

collected Schuh & Diesel, March-July 1996 (see Cuesta et al. 1999). 

 

Larvae  

Pre-processing 

Protocol. A number of protocols were applied to the larval specimens during the preparation 

of the slides, namely cleaning, staining, protein digestion, and mounting. Specimens were 

scanned using a Nikon A1-Si confocal microscope (Nikon Corporation, Tokyo, Japan) fitted 

to a Nikon Eclipse upright microscope. Generation of the 3D images was conducted using the 

open source software programme Drishti (version 2.6.1; Limaye, 2012). Other brands of 

http://imagej.nih.gov/ij/


5 

 

confocal microscopes including the Olympus Fluoview FV1000 IX81 inverted microscope 

(Olympus Corporation, Tokyo, Japan), Zeiss LSM 880 airy scan upright confocal microscope 

(Carl Zeiss, Jena, Germany), and Leica TCS SP5 (Leica Microsystems, Wetzlar, Germany) 

equipped with a Leica DM5000 B (upright microscope) were also tested using a protocol with 

the aim of finding a consistent workflow. In order to apply the same instructions to the different 

types of confocal image data, ImageJ was used before the application of Drishti (Fig. 2). 

 

Cleaning. For this study, laboratory hatched larval (zoeal) stages of the Chinese mitten crab 

(Eriocheir sinensis), previously fixed in 70% ethanol and deposited in the crustacean 

collections of the NHM, were scanned using CLSM. Numerous zoeae were contaminated with 

deposits that had adhered to the exoskeleton. The specimens were cleaned (see Sewell & 

Cannon, 1995; McAllen & Taylor, 2001) using Decon 90 (Decon Ltd., Sussex, England). Two 

or three drops of Decon 90 were added to 100 ml of 70% ethanol and specimens were left in 

this solution for 3 to 4 hours. This solution was gently agitated occasionally by hand during the 

cleaning process. The sonication methodology as proposed by Felgenhauer (1987) and the use 

of a tumbler were also trialled. After cleaning, the specimens were pipetted into deionised water 

for 5 minutes and washed thoroughly including three changes of 5 minutes each. The chemistry 

of the deposits was also investigated using X-ray spectroscopy using a LEO 1455VP SEM 

(Carl Zeiss, Jena, Germany) fitted with an Oxford Instruments X-Max 80 EDX (Oxford 

Instruments, Oxford, England) detector (see Supporting Information 1; SEM preparation). 

The SEM was operated in variable pressure mode (15Pa chamber pressure) at 20kV and the 

samples examined qualitatively in spot mode using internal standards.  

 

Staining and digestion. The larvae were stained using a 1:1 mixture of Congo red (Fisher 

Scientific Ltd., Loughborough, England) and acid fuchsin (Sigma-Aldrich Co. Ltd., Irvine, 
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England). These stains were available in powder form and each made into a stock solution by 

dissolving 0.5 mg of stain in 100 ml of deionised water. Stock solutions were filtered (Filtropur 

0.2 µm) to remove unwanted particles. The stains were stored in a cupboard at room 

temperature (ca. 20° C) in dark glass vials and covered with aluminium foil to protect them 

from the light which causes bleaching. Before staining the specimens, Congo red and acid 

fuchsin stock solutions were mixed 1:1 in a glass dish using separate plastic pipettes for each 

stain. Using mounted needles, the larvae were carefully lifted into the mixed stain, covered 

with a glass lid to prevent evaporation and left in a covered box for 24 hours at room 

temperature. The larvae were next transferred into a solution of SDS (5.2g (0.18M) SDS 

(sodium dodecyl sulphate) and 0.24g (0.03M) NH4HCO3 (ammonium hydrogen carbonate) in 

100ml deionised water) + DTT (0.1g 1, 4 dithio-DL-threitol in 5ml stock solution of SDS) to 

be digested (see Supporting Information 2; Preparation of SDS + DTT solution; Fischer & 

Ahlrichs, 2011). A few drops of the SDS + DTT solution (depending of the size and number 

of specimens) were dropped into a cavity slide. The stained specimen was placed into the 

solution and left until the muscles within the larvae were digested. For zoea I (ZI) larvae (Fig. 

3a) this was achieved in 75 minutes. As the size increased in subsequent zoeal stages (ZII–

ZVI), the duration of immersion in the SDS + DTT solution was increased depending on the 

stage of development, e.g. ZII (Fig. 3b) = 2−3 hours, ZIII (Fig. 3c) = 4−5 hours, ZIV (Fig. 3d) 

= 6−8 hours, ZV (Fig. 3e) = 10 hours, ZVI (Fig. 3f) = more than 10 hours. When digestion was 

complete, the larvae were rinsed three times in deionised water (each rinse lasting 5 minutes). 

Digested specimens were then transferred back into the mixture of Congo red and acid fuchsin 

where they remained for a further 24 hours in a box, at room temperature, for a final staining.  

 

Mounting in glycerine and specimen dissection. The use of a suitable mounting medium was 

essential in order to deliver optimum images using CLSM and for 3D re-construction purposes. 
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The larvae (ZI and ZII) were removed from the stain and transferred into a solution of 10% 

glycerine and 90% deionised water. This solution avoided shrinkage problems when 

transferring the larvae from the stain to glycerine for dissection, but this solution concentration 

was varied according to the stage and size of the larvae e.g. 25% glycerine and 75% deionised 

water was used for ZIII and ZIV, and 50% glycerine and 50% deionised water was used for 

ZV and ZVI. Before dissection, glass slides were prepared using self-adhesive reinforcement 

rings (Fig. 4) glued to the surface as described by Kihara & Falavigna da Rocha (2009). 

Reinforcement rings raised the cover slip above the slide and allowed more space for the 

dissected appendages to lie naturally in the cavity without being crushed and flattened. Two to 

three droplets of glycerine solution were pipetted into the cavity formed by the reinforced rings.  

The larvae were dissected under a Leica MZ 16 stereomicroscope (Leica Microsystems, 

Wetzlar, Germany) using tungsten wire needles (Clark & Cuesta, 2015). After dissection, the 

appendages were individually transferred into the prepared cavities of the glass slides. This 

ensured that the slide had a clean, debris free background for confocal microscopy. For  the 

pleon and larger appendages, the number of self-adhesive reinforcement rings used was 

increased (Michels & Büntzow, 2010). After the appendages had been placed into the cavities, 

they were carefully covered using 0.17 mm thick coverslip. After dissection and mounting, 

slides were kept in a dark area at room temperature prior to scanning as Congo red and acid 

fuchsin are affected by light. 

 

Confocal laser scanning microscopy 

The larval appendages were scanned using a Nikon A1-Si confocal microscope. Four lasers 

were available, 405 nm, 488 nm, 561 nm, 640 nm. Although an excitation wavelength of 561 

nm was recommended by Michels & Büntzow (2010) to match the optimal fluorescence of 

Congo red, a wavelength of 640 nm also proved effective. During scanning, all available 



8 

 

wavelengths were used so that no data were missed. For each preparation, the most appropriate 

objectives were chosen to match the size of the appendages.  

For larger appendages, such as the pleon, a 20× dry objective with a numerical aperture  

(N.A.) of 0.75 was used to obtain a general image before scanning at a higher magnification.  

Oil immersion objectives were used to increase resolving power of the microscope for scanning 

at 40× with N.A. of 1.30 and 60× with N.A. of 1.4 to produce higher resolution images of 

smaller larval appendages. Detector gain and amplitude offset were manually adjusted to 

deliver a black background. Setules (fine structures with a relatively low signal level) of the 

appendages, proved challenging to scan. To specifically visualise the setules, the offset was 

increased in order to make them apparent; this would also apply to any similar fine arthropod 

feature (fine setae, scales etc.). For image setting, the Z-intensity correction function was used 

to avoid oversaturating images. This function provided an opportunity to make colour 

adjustments between oversaturated or under saturated layers. Optimisation of the number of Z-

frames scanned was also required. 3D reconstruction required more Z-frames than 2D images, 

so the number of frames needed to be selected to match the final use case. Acquisition times 

were manually adjusted to deliver an acceptable background noise level and slides were 

typically scanned with 2× frame averaging. The format of all images is 1024×1024 pixels and 

these were viewed using maximum intensity projections as 2D image stacks.  

Two options can be applied to scan large appendages at higher magnification using 

CLSM. The first method uses the “large images” software option of the microscope and scans 

the sample in discrete areas known as tiles. The large images software option automatically 

stiches the tile together (Fig. 5a). Scanning duration, however, increases when applying this 

method and the resulting data sets can be extremely large. Manipulating such data sets may 

present problems during post-processing unless a powerful computer is made accessible. A 
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second option is to scan the sample in sections (i.e. basis and endopod separately; Fig. 5b, c) 

and then, after applying ImageJ and Drishti, merge these using Photoshop (Fig. 5d). 

Nikon confocal microscopes store the data stacks as ***.nd2 file; Leica as ***.lif; 

***.oib files for Olympus and ***.czi files for Zeiss (Fig. 6). Each manufacturer provides its 

own software package to visualise the image and to create maximum intensity projections. FV 

10−ASW 4.2 software was developed by Olympus; ZEN lite imaging software for Zeiss; LAS 

AF 2.2.1 software is used by Leica and NIS elements viewer (version 4.20) by Nikon. 

 

Post-processing using ImageJ and Drishtiimport  

The first method for importing image stacks into Drishtiimport involves the use of ImageJ.  

Instead of using the confocal manufacturer software packages, the image stacks are opened 

directly in ImageJ which splits the stack data into channels which can be viewed independently. 

At this point, the image properties (voxel size) should be noted in order to produce a scale bar 

later in Drishti. Any channels considered to be of insufficient quality can be ignored and the 

remaining channels merged. The advantage of using ImageJ is that merged channels can be 

converted to 8-bit composite images creating one common workflow for data from any brands 

of confocal microscope. The merged images can then be exported into Drishtiimport. Multi -

channel data can be easily manipulated by Drishti and produce images of much greater quality 

(see Supporting Information 3 & 4; Exporting stack data into ImageJ and Importing stack 

data into Drishtiimport, respectively). 

As an alternative method, the stack data files can be exported as TIFF images by 

separating the chosen excitation wave lengths (channels) using the software packages provided 

by the manufacturers to deliver a single image stack for each channel. Typically, only a single 

channel was selected for 3D modelling (Bourke, 2011). For this application, the orange channel 

(561nm) provided the optimal fluorescence signal for Congo red and acid fuchsin stains. All 
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stack images in one channel were then selected and transferred to a new folder (e.g. “Orange 

channel”). Image properties (voxel size) were noted for later reference in order to produce a 

scale bar in Drishti.  

Whichever workflow was chosen, the new folder was then imported into Drishtiimport  

which standardises the data and creates a ***.pvl.nc file called “volumes.pvl.nc” (see 

Supporting Information 4; Importing stack data into Drishtiimport). The user has the option 

to individually import all the channels into Drishtiimport to be saved as volumes. Although 

Drishti does provide an option to load more than one volume, the size of the files can be 

extremely large and may prevent the programme from operating. Furthermore, any resulting 

images tended to be over saturated. 

 

Visualisation of data using Drishti (3D Visualisation) 

After opening Drishti (Lovett, 2013), the volume files (***.pvl.nc) created in Drishtiimport 

were imported, processed and visualised in 3D. The processing capabilities of Drishti were 

used as follows. Before visualising the volumes in high resolution in 3D, the images were 

cropped to fit the scanned image or area of interest on the appendages. Adjusting the lighting 

option helped to visualise the setae on the appendages. Adding a scale bar and increasing the 

image quality was possible using the programme. As well as visualising the surface characters 

on the appendages in detail, Drishti allowed the 3D specimen dataset to be reoriented and more 

than one snapshot of the same appendage to be taken from different angles. Consequently, the 

exact number of setae and other details could be accurately determined. One of the most helpful 

options of the programme was the ability to edit pictures by removing debris or unwanted 

tissues on the images in 3D. Opening the “command help” box gave a number of different 

options for processing the volumes e.g. making videos. The images can be adjusted and 

improved (see Supporting Information 5; Drishti visualisation instructions). Final images 
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were adjusted in Adobe Photoshop. Adjustments included modifying the brightness and 

contrast, changing the image and canvas size, improving the quality and consistency of the 

Drishti scale bars, standardising the background, deleting any remaining debris and saving as 

a final image for publication. 

 

“Digital dissection”. This may also be referred to as “data cleansing” and/or “segmentation”. 

Unprocessed CLSM datasets frequently contained fragments of dissected debris and additional 

tissue which appeared to “float” in the 3D volume or which were attached to appendages. This 

unwanted data can be removed (cleaned) using Adobe Photoshop, but this option only affects 

the final 2D viewpoint of the 3D volume. Such editing may pose ethical issues with regards to 

alteration of the image since areas “behind” the fragment would also be removed and need to 

be “cloned” back into the image. A much better option was to remove the unwanted scanned 

fragments directly from the 3D volume using Drishti by rotating the specimen. From 

examination of the rotated specimen, the viewer can determine whether the fragment was a part 

of the specimen. If not, it can be removed to allow for an improved visualisation of the 

specimen. 3D volume manipulation therefore allowed for the specimen to be digitally dissected 

in post-processing and this was considered to be a much more powerful technique than simple 

2D image manipulation (see Supporting Information 6; Segmentation instructions). After the 

3D manipulation process, a 2D image was saved and edited in Photoshop.  

 

Results and discussion 

Cleaning and digesting 

Cleaning the specimens with Decon 90 proved to be an effective method of removing debris 

that had adhered to the exoskeleton (compare Figs. 3 with 7a). The sonication methodology 

proposed by Felgenhauer (1987) for cleaning aquatic arthropods, proved ineffective as it often 
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resulted in the natatory setae of the maxillipeds of the zoeae becoming tangled. A similar 

problem was encountered when using a tumbler. 

The results of the SEM-EDX analysis showed that debris found on limbs was composed 

of calcium carbonate (see Fig. 7a). These items of debris were effectively removed using the 

surface-active cleaning agent, Decon 90. 

Digesting the muscle within specimens using a mixture of SDS + DTT (Fischer & 

Ahlrichs, 2011) was an effective method of clearing the appendages, making them more 

transparent and fluorescent for CLSM imaging. This clearing of internal tissue also helped the 

visualisation of setae that were otherwise masked behind the muscles on the distal side of the 

appendage. Furthermore, dissection of zoeae became much easier after the specimen had been 

placed in the digesting solution. Another advantage of using the digestion mixture was to 

balance the acquisition settings of the microscope to avoid having over/under saturated images. 

As the setae provided a weaker signal than the main part of the exoskeleton, the settings of the 

channels needed to be increased to visualise these smaller structures. If the settings were 

increased, however, the main exoskeleton had a tendency to become over saturated because it 

yielded a stronger signal (Fig. 8a). This problem was resolved by digestion since its relative 

signal strength was reduced compared to that of the setae (Fig. 8b). 

If the appendage was not digested, however, some of the minute exoskeletal structures 

were “masked” (Fig. 9a) by the signal from basial musculature of the second maxilliped and 

did not appear when ImageJ and Drishti was applied to the confocal stack data (Fig. 9b). But 

after digestion of the basial muscles (Fig. 9c), these tiny structures could be visualised when 

fully processed (Fig. 9d). 

 

Comparing methods to eliminate oversaturation after staining 
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Congo red has been a commonly used external stain for crustaceans and polychaetes (Michels 

& Büntzow, 2010; Michels & Gorb, 2012) prior to CLSM. Although the present study 

demonstrated good results using Congo red alone for CLSM, some appendages were not 

completely saturated by the stain (Fig. 8c). This problem of patchy staining was mentioned by 

Michels & Büntzow (2010) and Böhm et al. (2011) who were attempting to stain small 

crustaceans, the cuticle of polychaetes and the tarsal sensilla of Protura. Michels & Büntzow 

(2010) clarified that Congo red stained the exoskeleton effectively, but was not so successful 

for internal tissues and proteins. Böhm et al. (2011) attributed this to the embedding medium 

and compensated for this by changing acquisition settings during CLSM imaging. In order to 

overcome this problem in the present study, Congo red was mixed with acid fuchsin, which is 

another effective stain of arthropod exoskeletons. The combination of Congo red and acid 

fuchsin greatly improved the overall saturation of staining and proved a more effective way to 

balance the acquisition settings compared to using Congo red alone (Fig. 8d). 

In addition, Michels & Büntzow (2010) suggested that after staining, specimens should 

be washed several times until the Congo red was no longer present prior to dissection. This 

was not found to be an issue in the present study because the specimens were removed from 

the stain and placed in a solution of diluted glycerine and then the appendages were dissected. 

The dissected appendages were then individually transferred to slides containing a fresh 

solution of dilute glycerine to be scanned; the specimens were thus effectively isolated from 

the Congo red. 

 

Comparison of mounting media 

Two types of mounting medium were initially trialled; polyvinyl lactophenol (permanent) and 

diluted glycerine (non-permanent). Polyvinyl lactophenol was placed on a glass slide, stained 

larvae were transferred directly into it, dissected and a cover-slip applied. Polyvinyl 
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lactophenol proved to be extremely viscous and hard when set, consequently manipulation of 

the appendages into an improved position for CLSM was almost impossible. An advantage of 

a hard setting mount was that during scanning the heat caused by the laser did not change the 

position of the specimen. It was not possible, however, to reposition the specimen or to use it 

for DNA extractions after scanning. In addition, during dissection, much debris was produced 

and these fragments adhered to the appendages (Fig. 7b-c) causing background noise. 

Furthermore, removing the debris from the appendage or background using Drishti or 

Photoshop proved extremely time-consuming and was not always successful (see circled areas, 

Fig. 7d). The background noise could be compensated for by increasing averaging times. But 

this could increase the duration of scanning (scan time doubled with 4 times averaging, tripled 

with 8 times averaging and quadrupled with 16 times averaging). Consequently, a clean 

background reduced the duration of scanning and helped to avoid bleaching of the stain. 

Another issue with polyvinyl lactophenol was it caused immediate shrinkage of the specimens 

that were transferred to the medium. The mountant could be diluted with alcohol to avoid 

specimen shrinkage, however, both polyvinyl lactophenol and alcohol, individually and 

together, did in time bleach the stained specimens.  

Glycerine was therefore the preferred mounting medium for CLSM studies. Shrinking 

specimens placed in diluted glycerine could be recovered with the addition of more deionised 

water and, furthermore, could be easily manipulated for re-positioning. A disadvantage of this 

medium, especially when diluted, was that it could be heated by the lasers during scanning. 

There was a tendency for it to liquefy which caused movement of the specimen. Another 

problem was the formation of air bubbles. Their expansion during scanning caused the 

specimen to move and the production of a blurred final image. Air bubbles also tended to form 

over time and appeared overnight between mounting the specimen and scanning. This was 

possibly because the initial volume of fluid was insufficient or evaporation had taken place 
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overnight. It was therefore better to scan directly after the sample had been mounted. 

Furthermore, samples could also lose their stain if allowed to remain in glycerine over long 

periods of time. 

 

Scanning procedures 

The use of reinforced rings to create adequate space under the coverslip (Fig. 4) proved to be 

effective in preventing samples from being crushed and distorted. Once the sample was 

correctly positioned the confocal microscope was able to obtain extremely high quality image 

data. For larger specimens it proved necessary to tile the sample (collect data as series of 

overlapping fields of view in X and Y and also Z) (Fig. 10) which led to long acquisition times, 

with consequent risk of specimen movement. The resulting data files were also exceptionally 

large and processing these data using Drishti required an extremely powerful computer. This 

problem was also solved by scanning the appendage in separate sections and merging these at 

the end of the scanning procedure using Photoshop (Fig. 11), however, this protocol was 

somewhat time-consuming. 

For smaller larval appendages, 40× and 60× oil immersion objective lenses were used 

to produce higher resolution images. Using a lower magnification objective lens to obtain a 

larger field of view was ineffective since the lower magnification lens did not provide adequate 

resolution to resolve fine setae (e.g. dorsal setae on somite of the pleon are not resolved with 

lower magnification lenses; Fig. 12). Lower magnification lenses also reduced resolution along 

the Z-axis and were thus not capable of obtaining sufficiently fine image slices for effective 

3D reconstruction in Drishti. The requirement to obtain large numbers of Z slices and for image 

tiling meant that confocal microscope data acquisition was relatively slow and could take 

several hours, hence the need to optimise the stability of the sample in the mounting medium. 
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ImageJ and Drishti 

The methodology and data processing workflow (Fig. 2) described here was successfully tested 

on confocal microscopes manufactured by Olympus, Zeiss, Nikon and Leica. The method for 

handling the data was the same and the ImageJ and Drishti import process was identical for 

each file format (Fig. 13). The final quality of merged channels images combining ImageJ and 

Drishti appeared to be an improvement compared to importing a single channel into Drishti 

(using the manufacturers’ own programmes to extract each channel). Merged channel images 

provided more information, especially with regard to the visualisation of setae. Drishti 

provided an added advantage in being able to reconstruct stack data and manipulation of 

images.  

Once 3D datasets had been acquired, Drishti proved to be a powerful tool in 

reconstructing the specimen from different viewpoints (Fig. 14) and also offered the advantage 

of allowing the user to remove parts of the specimen from the foreground to reveal features 

which would otherwise be obscured (a useful form of digital dissection; Fig. 14c). Various 

images of brachyuran crab larvae from different species (Eriocheir sinensis, Sesarma 

curacaoense, Armases miersii) were scanned using CLSM and processed with ImageJ, Drishti 

and Photoshop (see Figs. 15−17). 

Additionally, Drishti is a freeware software programme while other comparable surface 

rendering packages are extremely expensive. The visualisation packages produced by Nikon, 

Leica, Olympus and Zeiss are limited and not cross compatible, whereas ImageJ and Drishti 

are universal across all brands.  

 

Conclusions 

Conventional observation of fine features, as seen in brachyuran larvae, normally relies on light 

microscopy often using techniques such as DIC (differential interference contrast) or phase 
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contrast (Fig. 18). Furthermore, dissected appendages are challenging to mount as they can 

move whilst trying to fix them in an appropriate position. The narrow focal depth of compound 

microscopes may also make some direct observations difficult, as a result features can be 

overlooked. Consequently, many line drawings tend to simplify and codify the essential 

features for diagnostic illustrations. For specimens with complex topography and setation, 

however, this approach can be subjective and makes comparison difficult (Fig. 1b, c). In 

addition, traditional 2D photography, even with the addition of focal stacking, may not 

accurately record the 3D complexity of limbs and larval appendages or the position of setae. In 

comparison, high quality CLSM image data can be further enhanced by the use of Drishti. For 

example, in previous studies, the number of setae on the basis of the first maxilliped especially 

in the small early zoea stages, such as ZI and ZII (for correct setation see Figs. 13a; 16a) and 

the fine second seta on the first and second segments of the first maxilliped endopod were 

overlooked (for correct setation see Figs. 13b; 16b). In addition, one seta can mask another if 

it lies along the same image path, but on a different focal plane. The masked setae can be 

visualised by rotating the appendage using Drishti (see Figs. 9b, d; 17b). Another advantage of 

Drishti is the application of digital dissection and the removal of unwanted fragments (see Figs. 

11a; 14; 15c). 

The methodologies described here the combination of improved cleaning, digestion and 

preparation methods, allowing for reduced transfer of contaminants into the final slide mounts, 

the confocal data processing protocols and the possibility of post-acquisition removal of 

artefacts using free software have been shown to overcome all of the previous limitations in 

the use of confocal microscopy for the examination of small arthropods. Furthermore, the 

methodologies described for the use of Drishti to post-process samples have also been 

successfully applied to other confocal datasets and even been used for the production of 3D 

prints from the data. 
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The main limitation now remains the speed of the confocal microscope and its ability 

to handle and image larger specimens. “Macro confocal microscopes” have been assessed, but 

found to have inadequate resolution for this application. The use of high resolution micro-CT 

is currently being investigated as a complementary technique to provide further contextual 3D 

information on macro-invertebrates. 
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Captions 

Fig. 1. Eriocheir sinensis, zoea I, second maxilliped. A comparison of (a) SEM image obtained 

using Zeiss Ultra Plus Field Emission. (b) Line drawing from Kim & Hwang (1995). (c) Line 

drawing from Montu et al. (1996). (d) Drishti image obtained using Nikon A1-Si CLSM. Scale 

bars a = 20 μm; b-d = 100 μm.  

Fig. 2. A flowchart for visualisation and 3D imaging of brachyuran crab larvae. 

Fig. 3. Eriocheir sinensis zoeal stages using Nikon A1-Si CLSM. Confocal images. (a) ZI, 10× 

dry objective. (b) ZII, 10× dry objective applying “large images” option, scan area of 2×1 fields 

for image stitching. (c) ZIII, 10× dry objective applying “large images” option, scan area of 

2×2 fields for image stitching. (d) ZIV, 10× dry objective applying “large images” option, scan 

area of 3×2 fields for image stitching. (e) ZV, 10× dry objective applying “large images” 

option, scan area of 4×3 fields for image stitching. (f) ZVI, 10× dry objective applying “large 

images” option, scan area of 4×4 fields for image stitching. Scale bars = 500 μm. 

Fig. 4. Preparation of slide using reinforcement rings. 

Fig. 5. Eriocheir sinensis, zoea II, Drishti images of first maxilliped using Nikon A1-Si CLSM. 

(a) Basis and endopod, scan area of 1×2 fields for image stitching, 20× dry immersion objective 

applying “large images” option. (b) Endopod. (c) Basis. Both using 40× oil immersion 

objective. (d) Basis and endopod merged from two images using Adobe Photoshop, after 

applying ImageJ and Drishti. Scale bars a = 300 μm; b-d = 100 μm. 

Fig. 6. File formats of different confocal microscopes. Leica uses ***.lif files. Nikon uses 

***.nd2 files. Olympus uses ***.oib files. Zeiss uses ***.czi files.  

Fig. 7. Eriocheir sinensis, zoeae with debris adhered to the exoskeleton. (a) ZI showing calcium 

carbonate using SEM LEO 1455 VP analysis. (b) ZII, confocal image of endopod using Nikon 

A1-Si CLSM, 60× oil immersion objective. (c) ZII, Drishti image of endopod. (d) ZII, attempt 
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at debris removal using Drishti and Photoshop was not always successful, see circled areas. 

Scale bars a = 300 μm; b-d= 100 μm. 

Fig. 8. Advantages of staining and digesting appendages. Eriocheir sinensis, zoea I, scanned 

images of the maxilla using Nikon A1-Si CLSM. (a) Undigested and unstained, 60× oil 

immersion objective. (b) Digested and stained with Congo red and acid fuchsin, 40× oil 

immersion objective. (c) Undigested and stained using only Congo red, 60× oil immersion 

objective. (d) Undigested and stained using the mixture of Congo red and acid fuchsin, 40× oil 

immersion objectives. Scale bars a, c = 50 μm; b, d = 100 μm. 

Fig. 9. Advantages of digesting appendages. Eriocheir sinensis, zoea I, images of second 

maxilliped using Nikon A1-Si CLSM. (a) Confocal image of non-digested appendage showing 

basial musculature. (b) Drishti image of non-digested appendage. c) Confocal image of 

digested basial muscles. (d) Drishti image of digested appendage (tiny structures are circled). 

All 40× oil immersion objective, applying “large images” option, scan area of 1×2 fields for 

image stitching. Scale bars = 100 μm.  

Fig. 10. “Tiling” appendages when scanning at higher magnification. Eriocheir sinensis, zoea 

V, image of maxilla using Nikon A1-Si CLSM. (a) Confocal image showing tiled areas. (b) 

Drishti image. 40× oil immersion objective, applying “large images” option, scan area of 2×3 

fields for image stitching. Scale bars a = 100 μm; b = 200 μm. 

Fig. 11. Merging Drishti images using Adobe Photoshop. Eriocheir sinensis zoeal appendages 

using Nikon A1-Si CLSM. (a) ZII, maxilla, 40× oil immersion objective. (b) ZI, lateral view 

of pleon, 20× dry immersion objective. Scale bars a = 200 μm; b = 300 μm. 

Fig. 12. Visualisation of fine setae. Eriocheir sinensis, zoea I. Image of dorsal view of pleon 

using Nikon A1-Si CLSM, 40× oil immersion objective, applying “large images” option, scan 

area of 2×6 fields for image stitching. Scale bar = 200 μm. 



 
 

26 
 

 

Fig. 13. Scanned brachyuran crab larvae using different brands of CLSM processed in Drishti. 

Eriocheir sinensis, zoea I, first maxilliped. (a) Basis, Nikon A1-Si CLSM. (b) Endopod, 

Olympus Fluoview FV1000 IX8. (c) Antenna, Zeiss LSM 880 airy scan. All 40× oil immersion 

objective. (d) Sesarma curacaoense, ZIV, lateral view of pleon, Leica TCS SP5, 10× dry 

objective. Scale bars a-b = 100 μm; c = 50 μm; d =500 μm. 

Fig. 14. Digital dissection. Eriocheir sinensis, zoea I, image of maxillule using Nikon A1-Si 

CLSM and processed using Drishti. (a) Unwanted tissue arrowed. (b) Repositioning of 

appendage to allow the removal of unwanted tissue (arrowed). (c) After digital dissection of 

tissue (compare a with c). 40× oil immersion objective. Scale bars = 100 μm. 

Fig. 15. Drishti images of Eriocheir sinensis zoeal appendages using Nikon A1-Si CLSM: (a) 

ZII, antennule, 40× oil immersion objective. (b) ZI, antenna, 60× oil immersion objective. (c) 

ZI, maxillule, 40× oil immersion objective. Scale bars a, c = 100 μm; b = 50 μm. 

Fig. 16. Drishti images of Sesarma curacaoense, zoea I appendages using Leica TCS SP5. First 

maxilliped. (a) Coxa and basis. (b) Endopod. (c) Coxa and basis of second maxilliped. (d) 

Maxillule. All 40× oil immersion objective. Scale bars a-b = 50 μm; c-d = 100 μm. 

Fig. 17. Drishti images of Armases miersii, zoea IV appendages using Leica TCS SP5. (a) Coxa 

and basis of first maxilliped. (b) Endopod of second maxilliped. Both using 40× oil immersion 

objective. (c) Antenna. (d) Maxillule. Both using 20× dry objective. Scale bars a, d = 200 μm; 

b-c = 100 μm. 

Fig. 18. Comparing bright field and confocal images. Eriocheir sinensis zoea, images of second 

maxilliped using Nikon A1-Si CLSM. (a) ZI, bright field image of exopod, 20× dry objective. 

(b) ZIV, confocal image of exopod, 20× dry objective applying “large images” option, scan 

area of 1×2 fields for image stitching. Scale bars a = 50 μm; b = 100 μm. 
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Supporting Information 

 

1. SEM preparation 

Laboratory hatched first stage zoeae of Chinese mitten crabs (Eriocheir sinensis), previously 

fixed in 70% ethanol and deposited in the crustacean reference collections of the NHM, were 

used for SEM examination. Zoea I larvae contaminated with debris were cleaned using Decon 

90. Two or three drops of Decon 90 were added to 100 ml of 70% ethanol and specimens were 

left in this solution for 3 to 4 hours. This solution was occasionally gently agitated by hand. 

The sonication step as proposed by Felgenhauer (1987) or use of a tumbler were ignored as it 

often resulted in natatory setae of the maxillipeds becoming tangled. After cleaning, the 

specimens were pipetted into deionised water for 5 minutes and washed thoroughly including 

three changes of 5 minutes each. Next, the specimens were transferred to 30% ethanol from 

distilled water as the first step of the dehydration process. This was left for 30 minutes and later 

refilled with 30% ethanol for another 30 minutes. Then this step was applied to each 

concentration of the following until 100% dried ethanol.  

50% ethanol (2 × 30 min) 

70% ethanol (2 × 30 min) 

80% ethanol (2 × 30 min) 

90% ethanol (2 × 30 min) 

95% ethanol (2 × 30 min) 

100% dried ethanol (2 × 30 min) 

The specimens were then critical point dried prior to mounting and coating for SEM 

observation using a Zeiss Ultra Plus Field Emission SEM (see Fig. 1a). For debris analysis, 

samples were examined, uncoated, using a LEO 1455 VP SEM (see Fig, 7a). 

 

2. Preparation of SDS +DTT solution 
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Stock solution of SDS was prepared by adding 5.2 g (0.18 M) SDS (sodium dodecyl sulphate) 

and 0.24 g (0.03 M) NH4HCO3 (ammonium hydrogen carbonate) to 100 ml deionised water in 

an Erlenmeyer flask (pH 8.3). Then, the reducing agent, 0.1 g DTT (1,4-dithio-DL-threitol) 

was added to a 5 ml stock solution of SDS in a glass vial using a micropipette before each 

digestion process. The mixture of SDS + DTT was then shaken vigorously. The stock solution 

of SDS can be safely stored in a fridge for up to 6 months. Once SDS is mixed with DTT, the 

mixture should be used within a week as the mixture should be fresh. 

 

3. Exporting stack data into ImageJ 

Any stack data file can be opened in ImageJ. Opening ImageJ software programme (Supp. Fig. 

1), go to File> Open> click on data; click open (Supp. Fig. 2). 

 

 

Supp. Fig. 1. The menu bar for ImageJ. 
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Supp. Fig. 2. Opening stack data in ImageJ, e.g. Nikon_MaxillipedII_basis_ZII.nd2 has been 

selected. 
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Open stack data; select “Grayscale” from dropdown menu and select options 

“Autoscale” and “Split channels”; click OK (Supp. Fig. 3). 

 

 

Supp. Fig. 3. Import options for stack data. 
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The stack data will split into the number of channels scanned, in this example 4 (see 

Supp. Fig. 4); go to Image> Properties; note image properties (voxel size), this information is 

required for the reconstruction of an accurate scale bar in the final images. In this example, 

pixel width represents X, pixel height represents Y and voxel depth represents Z in microns. 

Record image properties, e.g. x = 0.31, y = 0.31 and z = 0.7 microns; click OK (Supp. Fig. 4). 

 

 

Supp. Fig. 4. Record image properties (voxel size) for later use, e.g. x = 0.31, y = 0.31 and z 

= 0.7 microns. 
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Now check scanned image quality of each channel: click ► to play image stacks; any 

channel not providing full information, e.g. corrupted scans, oversaturated images, or high level 

of background noise, these channels should not be selected when merging channels (Supp. Fig. 

5). 

 

 
Supp. Fig. 5. Click on ► to check image quality for each channel. 
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Go to Image> Color> Merge Channels… and click (Supp. Fig. 6). 

 

 

Supp. Fig. 6. Merging selected channels in ImageJ.  
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Select channels to be merged by clicking ▼; any channels not selected due to poor 

quality will not be merged; after selecting channels, click option “Create composite”; click OK 

(Supp. Fig. 7). 

 

 

Supp. Fig. 7. Selecting channels to be merged. 
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Next, go to Image> Color> Channels Tool…, click; More> Convert to RGB, click OK 

(Supp. Figs. 8−10). 

 

  

Supp. Fig. 8. Go to Image> Color> Channels Tool…. 

 

 

Supp. Fig. 9. Convert to RGB. 
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Supp. Fig. 10. Following ImageJ instructions. 

 

Next converted single merged channel from RGB color to 8-bit image; go to Image> 

Type and click 8-bit (Supp. Fig. 11). 

 

 

Supp. Fig. 11. Changing image from RGB color to 8-bit in ImageJ.  
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Then go to File> Save as > Image Sequence… and click; then OK in TIFF format (Supp. 

Figs. 12−13). 

 

  

Supp. Fig. 12. Save merged channel image stacks as image sequence. 

 

 

Supp. Fig. 13. Save merged channel image stacks to TIFF format; click OK. 
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Create and name a new folder; save image stacks to folder; click save (Supp. Fig. 14). 

 

 

Supp. Fig. 14. Save merged image stacks to new folder, e.g. ImageJ_Nikon_Maxilliped 

II_basis. 
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4. Importing stack data into Drishtiimport 

Go to http://sf.anu.edu.au/Vizlab/drishti/ and download Drishti. After downloading use 

“drishtiimport - Shortcut” icon (Supp. Fig. 15). 

 

 

Supp. Fig. 15. Shortcut icon for “drishtiimport”. 

 

Click on “drishti - Shortcut” icon and a blank window will appear. From post-

processing (3D Modelling) treatment, drag and drop either a new folder from the standard 

option (e.g. “Orange channel”) or ImageJ (e.g. “ImageJ_Nikon_Maxilliped II_basis”) into the 

“drishtiimport” window and the “Select Directory Type” window will automatically open; 

select 6th option “Grayscale TIFF Image Directory” (Supp. Fig. 16). 

 

http://sf.anu.edu.au/Vizlab/drishti/
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Supp. Fig. 16. Importing post-processing data into Drishtiimport. 

 

“Select Voxel Type” window appears; click OK (Supp. Fig. 17). 

 

 

Supp. Fig. 17. Following instruction for importing the data to Drishti. 
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Go to File> Save as (S) and name new file ***.pvl.nc which are referred to as volumes 

in Drishti, e.g. “MaxillipedII_basis_Drishti_import.pvl.nc”; click save (Supp. Fig. 18). 

 

 

Supp. Fig. 18. Save to ***.pvl.nc file which are referred to as volumes in Drishti. 
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A series of 5 windows will appear respectively; click OK (Supp. Fig. 19a-e). 

 

 

Supp. Fig. 19. Following save, a series of 5 windows will open; for each click OK. 
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The “Additional Information” window appears; recover noted “image properties” 

(voxel size) recorded from the standard manufacturers package or ImageJ (Supp. Fig. 4) and 

enter data manually by leaving one-character space between, x, y, and z values e.g. 0.31 nm, 

0.31 nm and 0.7 nm; click OK (Supp. Fig. 20). 

 

 

Supp. Fig. 20. Entering “image properties” (voxel size); x, y and z values.  

 

Click OK when “Done” appears. File will be saved as 

“MaxillipedII_basis_Drishti_import.pvl.nc”and“MaxillipedII_basis_Drishti_import.pvl.nc00

1” (Supp. Fig. 21). 
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Supp. Fig. 21. Saving the data to use in Drishti. 

 

5. Drishti visualisation instructions 

Open “Drishti” (Supp. Fig. 22); and either drag and drop the ***.pvl.nc file from drishtiimport 

or go to File> Load volume> Load one volume and select the ***.pvl.nc file, e.g. 

“MaxillipedII_basis_Drishti_import.pvl.nc” (Supp. Fig. 23). 

  

 

Supp. Fig. 22. Shortcut icon for “Drishti”. 
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Supp. Fig. 23. Load ***.pvl.nc file, e.g. “MaxillipedII_basis_Drishti_import.pvl.nc” into 

Drishti. 
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A 3D representation of the file can now be viewed. This initial volume can be cropped 

to fit the scanned image; left click and drag the crossed square when the red line appears (Supp. 

Fig. 24). 

 

 

Supp. Fig. 24. Cropping the initial scanned volume. 
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F2 is used to toggle between high resolution and standard mode. 1 is used to toggle the 

lighting. B is used to toggle between box frames present or absent. To zoom in/out the mouse 

wheel is used. Image quality and background colour can be adjusted, go to View> Preferences 

(see arrows on left of main window). For adjustments of offset and intensity of image use 

buttons in right window (Supp. Fig. 25). 

 

 

Supp. Fig. 25. Getting high resolution images and some useful tools for Drishti. 
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To add a scale bar, after opening the command help window by pressing the space bar, 

the command “scalebar 100” was entered, this applies a 100 µm scale bar to the image (Supp. 

Fig. 26). To change the location of the scale bar, click and drag it to the correct position.  

 

 
Supp. Fig. 26. Adding a scale bar in Drishti. 
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The image can be saved by clicking File> Save image (Alt + S); select image size; click 

OK (Supp. Fig. 27). 

 

 

Supp. Fig. 27. Saving the image and selecting image size. 
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Save snap shots by naming file and type, e.g. MaxillipedII_basis_Drishti.jpg; click 

Save (Supp. Fig. 28). 

 

 

Supp. Fig. 28. Naming image and saving in ***.jpg format. 
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Select “Mono Image” option in drop down box; click OK. The snapshot will be saved 

as an image in ***.jpg format (Supp. Fig. 29). The snap shot window will remain open and, 

the volume can be repositioned and a new snapshot saved. 

 

 

Supp. Fig. 29. Taking a snapshot by selecting Mono Image and saving image. 
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6. Segmentation instructions 

Segmentation is undertaken in high resolution via the F2 key and commences by depressing 

“spacebar” on keyboard; “Command Help” box appears and select or type “mop update off” 

in Command String box; click OK (Supp. Fig. 30). 

 

 

Supp. Fig. 30. Segmentation: selecting mop update off for 3D data using Drishti. 
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Depress the space bar again and select or type “mop carve” and click OK. Fragments 

to be removed/deleted can be rotated and cleaned by pressing shift + left click (Supp. Fig. 31). 

After editing, the procedure can be completed by pressing the space bar again and entering the 

command “mop carve off”; click OK.  

 

 

Supp. Fig. 31. Rotating and removal of unwanted fragments in 3D images using Drishti. 
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Adjusting opacity and colour interface by manipulating the dots (see Supp. Fig. 32). 

Add scale bar as described above (Supp. Fig. 26). 

 

 

Supp. Fig. 32. Adjusting opacity and colour of the image by manipulating interface. 

 

After the editing process, the image can be saved as “Mono Image” by clicking File> 

Save image as. If the image is saved as ***.jpg, the background will be black, if ***.tif the 

background is white. 
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Table 1. List of reviewed papers that used CLSM in the study of macro-invertebrates with information on studied material, stain, mounting 

medium, confocal microscope, visualisation and performance observed. 

 

References Species Stain Mounting 

medium 

CLSM Visualisation* Performance 

Bundy and 

Paffenhöfer 

(1993) 

Labidocera aestival, 

Eucalanus pileatus, 

Centropages velificatus 

(Copepoda) 

DiI (Dioctadecyl-

tetramethylindocarbocyanine 

perchlorate) 

Seawater Biorad 

MRC600 

VoxelView Optical cross-

sections of the 

specimens can 

be animated and 

rotated in 3D. 

Galassi et 

al. (1998) 

Moraria poppei, 

Parastenocaris vicesimal 

(Copepoda) 

Autofluorescence Polyvinyl 

lactophenol 

Sarastro 

2000 

Maximum 

intensity 

projection 

(MIP) 

CLSM provides 

better 

understanding of 

3D structure of 

copepods. 

Carotenuto 

(1999) 

Temora stylifera (Copepoda) Autofluorescence Seawater Zeiss 

410 

MIP A non-destructive 

and fast method 

to distinguish 

transparent 

copepod stages. 
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Buttino et 

al. (2003) 

Calanus helgolandicus 

(Copepoda, Calanoida), 

Hippolyte inermis 

(Decapoda) 

DiI (Dioctadecyl-

tetramethylindocarbocyanine 

perchlorate) 

Seawater Zeiss 

410 

Zeiss and 

Crisel 

instruments 

software 

packages 

MetaVue 

Using bright-field 

microscopy is 

time consuming, 

however, CLSM 

is an effective 

method for 

visualising 

copepod 

morphology. 

Klaus et al. 

(2003) 

Culex tarsalis, Drosophila 

melanogaster (Insecta) 

 

Autofluorescence 

Euparal, 

Glycerine 

jelly 

 

Zeiss 

510 

MIP, volume 

rendering 

and 

isosurface 

rendering 

MIP images can be 

ambiguous. 

Volume 

rendered models 

enhance surface 

features. 

Klaus & 

Schawaroch 

(2006) 

Drosophila melanogaster, 

Culex tarsalis, 

Cladochaeta inversa 

(Insecta) 

 

 

Autofluorescence 

 

Euparal, 

Glycerine 

jelly 

 

 

Zeiss 

510 

Zeiss LSM 

image 

browser for 

MIP and 

Imaris 

Using spacer 

between 

coverslips 

protects 3D 

structure of the 

specimens. MIP 

images are 

good, but Imaris 

provides more 

satisfactory 

visualisation. 

Michels 

(2007) 

Acanthocyclops mirnyi, 

Heterorhabdus sp., 

Alteutha potter (Copepoda) 

 

 

Autofluorescence 

Euparal, 

Glycerine 

jelly 

 

 

Leica 

TCS SP5 

 

 

Amira 3D 

software 

Euparal produces 

red 

autofluorescence 

at excitation 
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wavelength of 

488nm or less.  

 

Glycerine jelly is a 

favourable 

embedding 

medium to 

visualise tiny 

structures of 

crustaceans. 

Schawaroch 

& Li (2007) 

Drosophila melanogaster 

(Insecta) 

Autofluorescence Glycerine 

jelly 

(mixture of 

mountants) 

Zeiss 

510 

Zeiss LSM 

image 

browser for 

MIP and 

Imaris 

Using agarose with 

glycerine jelly 

decreases 

background 

noise. Using 3D 

image re-

construction 

removes low 

level of 

background 

noise. 

Valdecasas 

(2008) 

Water mites; Vagabundia sci 

(Axonopsinae 

(Acari,Parasitengona, 

Hydrachnidia) 

Autofluorescence Glycerine 

jelly 

 

Leica 

TCS SP2 

ImageJ CLSM provides 

more efficient 

results than 

bright field 

microscope 

results. 

Lee et al. 

(2009) 

 

Carpatolechia (Insecta) 

Autofluorescence, 

Mercurochrome, Safranine, 

Chlorazol black E, Eosin Y, 

 

Euparal 

 

Zeiss 

LSM 

510 

 

MIP 

Autofluorescence 

level of chitin 

was low. The 

best results were 
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Eosin Y + Chlorazol black 

E, Orange G 

 

obtained using 

eosin Y, 

safranine and 

mercurochrome 

respectively. 

Poor images 

were obtained 

using orange-G 

and eosin Y + 

chlorazol black 

E. 

Maruzzo et 

al. (2009) 

Artemia (Crustacea, 

Branchiopoda, Anostraca) 

Evans Blue  Glycerol Nikon 

Eclipse 

E600 

MIP Specimens digested 

in KOH and 

stained with 

Evans Blue 

provided better 

results. 

Butler et al. 

(2010) 

Ballonema gracilipes 

(Chilopoda) 

Autofluorescence Canada 

balsam 

Leica 

TCS SP1 

MIP Non-destructive 

imaging for 

historical 

museum 

material. 

Resolution is 

comparable to 

SEM. Canada 

balsam makes 

specimens more 

fluorescent for 

CLSM 

visualisation. 
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Michels & 

Büntzow 

(2010) 

 

Small crustaceans and 

polychaetes 

Autofluorescence, Congo red  

Glycerine 

 

Leica 

TCS SP5 

 

Leica LAS 

software for 

MIPs 

Congo red stains 

exoskeleton 

effectively, but 

internal tissues 

and proteins 

were not stained 

so successfully. 

 

 

 

 

Böhm et al. 

(2011) 

 

 

Ionescuellum carpaticum 

(Protura, Entognatha 

Artrophoda) 

 

Autofluorescence 

 

 

 

 

 

 

 

Congo red 

 

Polyvinyl 

lactophenol 

(unstained), 

Euparal 

(Congo 

red) 

 

 

 

 

 

Leica 

TCS SP 

2 

 

 

 

 

 

MIP, 

Fiji, 

OsiriX 

Congo red fades in 

polyvinyl 

lactophenol, any 

mountant such 

as Euparal can 

be used so long 

as it is not 

strongly 

autofluorescent. 

 

Autofluorescence 

of unsclerotised 

cuticle is low. 

Stained regions 

with Congo red 

was effective. 

Menzel 

(2011) 

Mesocletodes elmari sp. 

(Copepoda, Harpacticoida, 

Argestidae) 

Congo red Glycerol 

 

Leica 

TCS SP5 

MIP Successful 

visualisation. 

Valdecasas 

& Abad 

(2011) 

Aquatic mites (Acari, 

Hydrachnidia) 

Autofluorescence Glycerine 

jelly 

Leica 

SPE 

ImageJ to 

obtain 

MIPs, 

Gamma 

correction 

Using proteinase K 

does not affect 

the external 

morphology of 

mites. 
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with 

Photoshop 

CS3 

Brooker et 

al. (2012) 

Lernaeocera branchialis 

(Copepoda) 

Blankophor, Gomori’s 

trichrome 

 

Distilled water 

 

 

Leica 

TCS SP2 

Leica Confocal 

Software 

(MIP), 

Photoshop 

CS3 

Successful 

visualisation. 

 

Brooker et 

al. (2012) 

 

Lernaeocera branchialis 

(Copepoda) 

 

Blankophor, Gomori’s 

trichrome 

 

 

Distilled water 

 

 

 

Leica 

TCS SP2 

LCSM 

composite 

images in 

Photoshop 

CS3 

Using 3D CLSM 

stack data to 

draw specimens 

digitally 

provides 

accurate data. 

 

Kihara & 

Martinez 

Arbizu 

(2012) 

Cerviniella danae, sp. nov., 

Cerviniella arctica sp. 

nov., Cerviniella hitoshii 

sp. nov. (Copepoda, 

Harpacticoida) 

Congo red Glycerine 

 

Leica 

TCS SP5 

LAS AF 2.2.1. 

for MIPs 

and CLSM 

illustrations, 

Adobe 

Photoshop 

CS4 

For the taxonomic 

study of new 

species, CLSM 

is used to 

visualise the 

details of the 

appendages of 

the specimens. 

 

Michels & 

Gorb (2012) 

Locustamigratoria,Sympetrum 

striolatum, Eristalis tenax 

and so on (Insecta), 

Temora longicornis 

(Copepoda) 

Autofluorescence, Congo red  

 

 

Glycerine 

 

 

 

 

Zeiss 

LSM 

700 

 

 

 

ZEN software 

CLSM is a good 

tool to visualise 

resilin in 

arthropods. It is 

also effective to 

detect the 

differences in 

the material 

composition. 
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Michels et 

al. (2012) 

Centropages hamatus 

(Copepoda) 

Congo red, Fluorescein 

isothiocyanate 

 

Glycerine 

Zeiss 

LSM 

700 

Nikon Capture 

NX 2, 

Adobe 

Photoshop 

CS4 

Successful 

visualisation. 

Brandt et al. 

(2014) 

Atlantoserolis vemae 

(Isopoda: Serolidae) 

Congo red and acid fuchsin Glycerine Leica 

TCS 

SPV 

LAS AF 2.2.1. 

for MIPs 

and CLSM 

illustrations, 

Adobe 

Photoshop 

CS4 

Stained whole 

specimen and 

the dissected 

parts (e.g. 

mouthparts and 

legs) were 

visualised using 

CLSM. 

 

Kaji et al. 

(2014) 

Clam shrimp (Crustacea, 

Branchiopoda) 

Rhodamine, Phalloidin  

Vectashield 

 

Leica 

TCS SP5 

II 

 

Imaris 

The cuticle surface 

is smooth and 

fine setae are 

present using 

Imaris. 

Dreszer et 

al. (2015) 

Cyphophthalmus solentiensis 

sp. nov. (Arachnida) 

Autofluorescence 

 

Glycerine Zeiss 

Elyra 

Carl Zeiss Zen 

software 

Successful 

visualisation by 

taking 

advantage of the 

autofluorescence 

of the arthropod 

cuticle. 

Wilkommen 

et al. (2015) 

Ischnura elegans (Insecta) Autofluorescence 

 

Glycerine Zeiss 

LSM 

700 

ZEN 2009 for 

MIPs 

Successful 

visualisation. 

*Some of the papers did not provide detailed information on visualisation.  
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Please click link below to find paper photos with original sizes: 

https://www.dropbox.com/sh/lopvjnhr0parn96/AADIv0T4S76hnqU3QWlGAa8La?dl=0 

  

https://www.dropbox.com/sh/lopvjnhr0parn96/AADIv0T4S76hnqU3QWlGAa8La?dl=0
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Fig. 1. Eriocheir sinensis, zoea I, second maxilliped. A comparison of (a) SEM image obtained 

using Zeiss Ultra Plus Field Emission. (b) Line drawing from Kim & Hwang (1995). (c) Line 

drawing from Montu et al. (1996). (d) Drishti image obtained using Nikon A1-Si CLSM. Scale 

bars a = 20 μm; b-d = 100 μm. 
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Fig. 2. A flowchart for visualisation and 3D imaging of brachyuran crab larvae. 
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Fig. 3. Eriocheir sinensis zoeal stages using Nikon A1-Si CLSM. Confocal images. (a) ZI, 10× 

dry objective. (b) ZII, 10× dry objective applying “large images” option, scan area of 2×1 fields 

for image stitching. (c) ZIII, 10× dry objective applying “large images” option, scan area of 

2×2 fields for image stitching. (d) ZIV, 10× dry objective applying “large images” option, scan 

area of 3×2 fields for image stitching. (e) ZV, 10× dry objective applying “large images” 

option, scan area of 4×3 fields for image stitching. (f) ZVI, 10× dry objective applying “large 

images” option, scan area of 4×4 fields for image stitching. Scale bars = 500 μm. 
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Fig. 4. Preparation of slide using reinforcement rings. 
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Fig. 5. Eriocheir sinensis, zoea II, Drishti images of first maxilliped using Nikon A1-Si CLSM. 

(a) Basis and endopod, scan area of 1×2 fields for image stitching, 20× dry immersion objective 

applying “large images” option. (b) Endopod. (c) Basis. Both using 40× oil immersion 

objective. (d) Basis and endopod merged from two images using Adobe Photoshop, after 

applying ImageJ and Drishti. Scale bars a = 300 μm; b-d = 100 μm. 
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Fig. 6. File formats of different confocal microscopes. Leica uses ***.lif files. Nikon uses 

***.nd2 files. Olympus uses ***.oib files. Zeiss uses ***.czi files.  
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Fig. 7. Eriocheir sinensis, zoeae with debris adhered to the exoskeleton. (a) ZI showing calcium 

carbonate using SEM LEO 1455 VP analysis. (b) ZII, confocal image of endopod using Nikon 

A1-Si CLSM, 60× oil immersion objective. (c) ZII, Drishti image of endopod. (d) ZII, attempt 

at debris removal using Drishti and Photoshop was not always successful, see circled areas. 

Scale bars a = 300 μm; b-d= 100 μm. 
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Fig. 8. Advantages of staining and digesting appendages. Eriocheir sinensis, zoea I, scanned 

images of the maxilla using Nikon A1-Si CLSM. (a) Undigested and unstained, 60× oil 

immersion objective. (b) Digested and stained with Congo red and acid fuchsin, 40× oil 

immersion objective. (c) Undigested and stained using only Congo red, 60× oil immersion 

objective. (d) Undigested and stained using the mixture of Congo red and acid fuchsin, 40× oil 

immersion objectives. Scale bars a, c = 50 μm; b, d = 100 μm. 
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Fig. 9. Advantages of digesting appendages. Eriocheir sinensis, zoea I, images of second 

maxilliped using Nikon A1-Si CLSM. (a) Confocal image of non-digested appendage showing 

basial musculature. (b) Drishti image of non-digested appendage. c) Confocal image of 

digested basial muscles. (d) Drishti image of digested appendage (tiny structures are circled). 

All 40× oil immersion objective, applying “large images” option, scan area of 1×2 fields for 

image stitching. Scale bars = 100 μm.  
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Fig. 10. “Tiling” appendages when scanning at higher magnification. Eriocheir sinensis, zoea 

V, image of maxilla using Nikon A1-Si CLSM. (a) Confocal image showing tiled areas. (b) 

Drishti image. 40× oil immersion objective, applying “large images” option, scan area of 2×3 

fields for image stitching. Scale bars a = 100 μm; b = 200 μm. 
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Fig. 11. Merging Drishti images using Adobe Photoshop. Eriocheir sinensis zoeal appendages 

using Nikon A1-Si CLSM. (a) ZII, maxilla, 40× oil immersion objective. (b) ZI, lateral view 

of pleon, 20× dry immersion objective. Scale bars a = 200 μm; b = 300 μm. 

  



 
 

74 
 

 

 

 

Fig. 12. Visualisation of fine setae. Eriocheir sinensis, zoea I. Image of dorsal view of pleon 

using Nikon A1-Si CLSM, 40× oil immersion objective, applying “large images” option, scan 

area of 2×6 fields for image stitching. Scale bar = 200 μm. 

  



 
 

75 
 

 

 

 

Fig. 13. Scanned brachyuran crab larvae using different brands of CLSM processed in Drishti. 

Eriocheir sinensis, zoea I, first maxilliped. (a) Basis, Nikon A1-Si CLSM. (b) Endopod, 

Olympus Fluoview FV1000 IX8. (c) Antenna, Zeiss LSM 880 airy scan. All 40× oil immersion 

objective. (d) Sesarma curacaoense, ZIV, lateral view of pleon, Leica TCS SP5, 10× dry 

objective. Scale bars a-b = 100 μm; c = 50 μm; d =500 μm. 
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Fig. 14. Digital dissection. Eriocheir sinensis, zoea I, image of maxillule using Nikon A1-Si 

CLSM and processed using Drishti. (a) Unwanted tissue arrowed. (b) Repositioning of 

appendage to allow the removal of unwanted tissue (arrowed). (c) After digital dissection of 

tissue (compare a with c). 40× oil immersion objective. Scale bars = 100 μm. 
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Fig. 15. Drishti images of Eriocheir sinensis zoeal appendages using Nikon A1-Si CLSM: (a) 

ZII, antennule, 40× oil immersion objective. (b) ZI, antenna, 60× oil immersion objective. (c) 

ZI, maxillule, 40× oil immersion objective. Scale bars a, c = 100 μm; b = 50 μm. 
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Fig. 16. Drishti images of Sesarma curacaoense, zoea I appendages using Leica TCS SP5. First 

maxilliped. (a) Coxa and basis. (b) Endopod. (c) Coxa and basis of second maxilliped. (d) 

Maxillule. All 40× oil immersion objective. Scale bars a-b = 50 μm; c-d = 100 μm. 
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Fig. 17. Drishti images of Armases miersii, zoea IV appendages using Leica TCS SP5. (a) Coxa 

and basis of first maxilliped. (b) Endopod of second maxilliped. Both using 40× oil immersion 

objective. (c) Antenna. (d) Maxillule. Both using 20× dry objective. Scale bars a, d = 200 μm; 

b-c = 100 μm. 
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Fig. 18. Comparing bright field and confocal images. Eriocheir sinensis zoea, images of second 

maxilliped using Nikon A1-Si CLSM. (a) ZI, bright field image of exopod, 20× dry objective. 

(b) ZIV, confocal image of exopod, 20× dry objective applying “large images” option, scan 

area of 1×2 fields for image stitching. Scale bars a = 50 μm; b = 100 μm. 

 


